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DISCLAIMER 
 

Each device manufactured, marketed and / or otherwise placed on the market - directly and / or indirectly by the 
manufacturer is made in accordance with the provisions and regulations in force in their user manuals contain 
the necessary information to ensure intended use and to identify the manufacturer, whilst taking into account the 
training / experience and knowledge of its intended users. 
 
This information, including that contained in the accompanying manuals for our products and our technical 
advice, whether verbal, in writing or by way of demo and experiment, is provided on the basis of our best 
knowledge. However, they must be considered as information without any binding effect, including those with 
respect to any industrial property rights of third parties, and do not exempt the customer from checking the 
current versions of our advice and suggestions, in particular of our material safety data sheets, instruction 
manuals and technical information, and products supplied by us, in order to estimate their suitability for the 
intended purpose and processes. 
 
The application, use and processing of our products and the products manufactured by the customer on the 
basis of our technical advice and / or maintenance activities occur outside of our control and fall, therefore, 
entirely under the customer’s own responsibility, for which the manufacturer assumes no responsibility as set 
out below. 
 
The technical results and / or data resulting from handling or use of our devices must be analyzed by 
experienced professionals in various fields of application of the specific product being otherwise compromised 
the correct reading and analysis of data. 
 
The sale of our products is governed by our General Conditions of Sale and Delivery as amended. 
 
The software provided by us in conjunction with our products or otherwise made available for download on your 
computer or for use online are the exclusive property of the manufacturer which disclaims any responsibility for 
the accuracy of the results obtained with the programs or algorithms used by the programs themselves or 
liability resulting from the incorrect use of the software. 
 
For data security, please refer to the management of Windows security. It is recommended to enter a password 
to access the account used. 
 
Before performing an upgrade of the application or the archive, and / or at least before any maintenance 
operation, we advise to make a backup of the complete patient database. It is also recommended you 
periodically (every week at least) make a backup on a different medium of the one normally used (e.g. CD-ROM 
or DVD). The manufacturer srl bears no liability for loss of data due to improper handling of the archive. 
 
All measured data, calculated and interpreted and subsequently displayed to the user must be considered 
subject entirely to customer's responsibility. The manufacturer remembers that any data and / or information 
arising from the use of the above software must necessarily be compared and verified with results from other 
devices in order to verify the exact calibration of the instruments and their proper functioning according to the 
specific parameters provided by the customer. 
 
 
The manufacturer does not assume any responsibility for damage of any kind howsoever arising and especially 
the application of the results of the Summary of Cataract in the software, including those arising from an 
incorrect calculation of the IOL. The user of the program must verify by plausibility considerations that the 
proposed values do not contain gross mistakes. 
 
The manufacturer assumes no responsibility and makes no guarantee of accuracy, calibration and / or exact 
measurements provided by the Products and / or software with which they operate even if provided by the 
manufacturer itself. 
 
Consequently, the manufacturer will not and cannot be held responsible in any way or for any reason for any 
direct, indirect, consequential in general, of image, or profit loss, or moreover of any kind or species whether 
they are persons, property or other equipment or products that the customer complaints as a direct or indirect 
consequence of the use of our products and our software. 
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1 INSTALLATION AND START-UP 
 
1.1 First installation 

Pass to chapter 1.3 if the AnaEyes software has just been installed. 

Insert the CD and wait for the installation procedure to start: 

If Framework 4.0 is not installed on the PC, the next screen will be displayed. 
Accept the licensing conditions and click Accept. 

 

 
Figure 1-1: Accept installation of framework 

 
 
 

Wait until the component is installed. 
 
 

 

Figure 1-2: Framework installation 

 
Upon completion of the procedure outlined below or if Framework is already installed, click Next to begin in- 
stalling AnaEyes. 
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                   Figure 1-3: AnaEyes Installation 
 

 
Select the file path for software installation and click Next. 
We recommend not changing the default file path displayed. 

 
 

 

Figura 1-4 Installation directory Figura 1-5 Confirmation  installation 
 

 
Click Next to complete installation; Click Close at the end of installation. 

 

 
The following screen appears. Click OK to confirm and proceed installation of a demo database, 
Cancel in case of an upgrade. 
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Figura 1-6 - Install DB 

 
 

 
 
 
 

 
 
The “AnaEyes” icon will appear on the desktop. 
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1.2 Upgrade 

 
In case of an upgrade of the AnaEyes software (i.e. an installation of the AnaEyes software on a system 
where an older version already was installed), the following message might appear upon uninstalling the old 
version: 

 
 
 

 

Figura 1-7 - Service active 

 
This means the WCF service menu has been used to install the Web Service interface for AnaEyes. Please 
make sure to uninstall the service, following Start Menu -> All Programs -> Essilor -> AnaEyes -> WCF 
Service-> Uninstall PSvcHost 

 
 

 
 
 

After this, the uninstall will correctly complete. See the appendix for more information on the installation of the 
WCF Sercvice. 
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1.3 AnaEyes Program Start-up 

Regarding Windows 8 users: after having installed AnaEyes on the Operating System Windows 8, it is neces- 
sary to start the program with an elevated level of privilege. We advise to choose the setting from properties 
like below: 

 
 

 
 

Figure 1-8 Set the privilege level 
 
 
 
 

Click the AnaEyes icon on the desktop. The screen shown below will appear, asking the user to send an e-mail 
containing the code for unlocking the software. 
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Figure 1-9: Registration Screen 

 
You need to connect the database when you open the first time the software. Press OK if the database 
has been created during the installation and AnaEyes is ready to use. 

 
If the database is just present, press browse button and select AnaEyes.mdb. You need to connect the 
root.cso file contents in the same database folder. Open the Miscellaneous menu in the settings and check 
if the Image root file is complete. Otherwise search the root.cso that will be in the database AnaEyes.mdb 
folder (see 4.4). 

 

 
Figure 1-10: Database connection 

 

Confirm  pressing OK. The main screen will open. 
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                       Figure 1-11: Main Screen of the AnaEyes Program 
 
 
 

This first screen allows the user to manage the database of patients and the examinations associated 
with each. It is made up of various sections and menus. 

 
When the program is launched, all the windows are empty. 

 

1.4 File Menu  
 
 

 
Settings 

 

Allows the user to select the software language, manage groups and instruments, and make other settings 
(see Chapter 4). This menu may be accessed only if the patient list is not displayed. If patients are displayed  

 

in the list,click                [Clear Patient List] to enable the Settings function. 

 

 Esc (Exits and closes the program). 

 

 

 
 

                                     Figure 1-11: Confirm  Exit from Program 
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Selecting the suitable box on the Settings/Other menu (see Chapter 4), displays a request for confirmation  of 
exit from program. Click Yes to exit or No to continue using the program. 

 
All data measured, calculated and successively displayed to the user are to be considered 
subject to the user's full responsibility. SL/DS550shall use its best endeavors in order to 
ensure that all the data displayed in the software is complete and accurate. Nevertheless 
the instrument's manufacturer bears no liability for any consequential damages and will not 
accept claims that result from incorrect data, and successive incorrect interpretations. Data 
obtained from the software should always be compared and scrutinized with results of different 
instruments. 

 
 

2. PATIENTS DATABASE 
 

 
 

Figure 2-1: Search Panel 

 
Each patient is identified by Last Name, First Name, and an Identification Code that is automatically generated 
by the program. 
To locate a patient in the Database, type the Last Name and First Name in the Patient Box or type the 
Identification Code. 
 
 
To select a search criterion, click the button alongside Last Name, First Name or alongside the Identification 
Code. 

 
To view a patient, type his/her Last Name, First Name (or Identification Code) in the Patient Box. As 

the letters or numbers are typed, the pull-down list will display patients meeting the criteria. If the typed 

characters do not yield any results, a warning icon will appear  . The warning icon is also displayed in 
the case an excessive number of results is returned. 

 
Once a patient is selected, his/her Last Name, First Name (with Identification Code and date of birth) will be 
displayed in large type in the top portion of the screen. 

 

 Fill Patient List 

Displays all the patients entered in the database. 
 
 
 
 

Empty Patient List 

 
Empties the contents of the window in which the patient list is displayed but does not delete the 
patients from the database. 

 
 
 
 

Search 
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Permits searching patients in the database by gender, date of birth, check-in number, examination 
date, patient age, referring physician, instrument, or group (see Paragraph 2.5). 

 
 

 

To enter a new patient in the database, click the            icon on the main screen to open a new window 
Enter the patient data in the window: last name, first name, date of birth, and gender. Typing a Last Name, 
First Name pair in the Patient Box automatically opens the window for entering the data for the new 
patient. 

 

 
 

Figure 2 2: New Patient Data Window 

 

Date of birth must be entered in the form: two digits for the day, two digits for the month, and four digits for the  

year. Entering an invalid datum will cause a warning icon   to be displayed 

Entering a patient whose data are identical to those of a patient already contained in the database will likewise 
open a window containing a warning message. 

 
The identification code is automatically entered by the system unless a different option is selected from the 
DICOM Settings menu. See Chapter 4.4. 

 
To confirm  new patient entry, press the Enter key or click the [OK] button. To cancel, click [Cancel]. 

 
Whenever a new patient is created, an examination associated with that patient is also created. A window for 
selecting the examination type then opens (See New Exam below). 
 

 

 
2.1 Patients List 

Any new patient entered is displayed in the patients list window on the left-hand side of the screen. To view the 

list of all the patients entered, click the button. To empty the contents of the patients list from the main 

screen, click the                 button. 
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button to the left of the name. 

2.2 Patient data 

When a patient is selected, the entered data will be displayed on the main screen (red rectangle). 

 

 
 

Figure 2 3: Patient Data 

 
2.3 Editing Patient data 

 
To edit the patient data, move the mouse pointer to the patient name and right-click. 

 

Select   , which reopens the patient data window for editing the last name, first 
name, date of birth, and/or gender. Click OK after having made all required changes. 

 
2.4 Selecting a Patient 

 
A patient already listed in the database can be selected in a number of different ways: 

 
● Type a last name and fi name in the Patient Box. In order to insert the last name and name correctly 

you must type: Last Name comma First Name, without spaces. If the typed name does not 
correspond to any patient already present in the database, press Enter to open the window for 
entering a new patient. 

 

● Click the button and use the ↑ ↓ keyboard keys to scroll the patients list or select a patient 

directly from the list. With the Patient Box empty, press Enter or double-click the highlighted 

patient name. A patient archive may be opened by clicking the 
 

● Type in a portion of the Last Name, First Name string to display a list of patient names meeting the 
criteria. To select a particular patient, proceed as described in the previous point. For instance, 
you may display all the patients whose names begin with a given letter, or who have the same last 
name, or who have the same last name and the same first-name initial, etc. 

 
When a patient is selected, the list of associated examinations opens automatically (see Chapter 3: 
Examina- tions Database). 
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2.5 Advanced Search 
 

Click the  button to access the advanced search function. 
 

  

Figure 2-4: Advanced Search 
 

 

For each of these categories, clicking the  , button so as to check (select) it  , visualizes the boxes for 
entering search criteria: 

 
• by gender: male or female 
• by date of birth: start and end dates of the interval to be searched 
• by check-in number: a box for entering the number; refer to the automatic completion function 
• by examination date: start and end dates of the interval to be searched 
• by patient age: minimum and maximum age 
• by referring physician: a box in which to type the physician’s name 

• by instrument: a list of possible examination capture instruments (for example, Fundus camera, 
kerato  scope, pupillographer, Scheimpflung camera, slit lamp biomicroscope) 

• by group: a list of the groups created via the Settings function (see Chapter 19) 
• by caption: the caption added to a single acquisition is used as a search parameter 

 
Select the boxes that permit establishing the search criteria. Click [Search] to display the search results. 
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2.6 delete Patient 
To delete a patient name, right-click the patient, select                                             and then confirm the deletion 
request warning message. 

Warning: deleting a patient also deletes all the examinations associated with that patient and the relative images. 

 
 

 
3. EXAMINATIONS  DATABASE 
An unlimited number of examinations may be associated with each patient; the examinations are defined    
on the basis of the instrument used and the date of creation. 

 
3.1 New Exam 

 

After a new patient is created, an examination will also be created. 

 
To create a new examination for an existing patient, click the            button. 

 
If working with a single instrument, the image capture mode will be automatically accessed. Otherwise, if at 
least two instruments are used, the window shown below will open. Select the instrument to be associated with 
the current examination. After selection, the capture mode is accessed. 

 

 
 

Figure 3-1: Instrument Selection 

 
Each examination is filed by date of creation and instrument type. It is also possible to attribute a pathology 
group [Group ]. Classifying the examinations by codified groups is useful for conducting searches. The groups 
list may be edited from the Settings menu (see Paragraph 4.3). 

 

3.2 Selecting an Examination 
 
Once a patient has been selected, click the button or press Enter or double-click with the mouse to access 
the Examinations Database. 
Clicking the + symbol to the left of the patient name opens the list of examinations associated with that patient. 
The + symbol becomes a – . Click the – symbol to close the list. 
Alternatively, open the list by pressing the → arrow key on the keyboard and close it by pressing the  ← arrow key. 

 

To select a previously-stored examination, use the mouse or scroll with the ↓↑. keyboard arrows to highlight one 
examination after another and, for each, view the relative images in the window on the right-hand side of the screen. 
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3.3 Editing Examination data 
 

To edit the data for an examination, select the exam, right-click, and select the 
 

  command [Edit Exam Data]. 

 

 
 

Figure 3-2: Editing Exam Data 

 
This action opens a window in which the user may edit the date and time of the exam, enter the name of a re- 
ferring physician and add a description of the exam. Click OK to confirm the changes; otherwise, click Cancel. 

 
3.4 deleting an Examination 

 

To eliminate a patient examination from the database, select the examination to be deleted by right-clicking, then 

clicking and confirming  the deletion request warning message. 

Warning: deleting an examination also deletes all the images associated with it. 
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3.5 refraction 

 
When an exam is selected, the (Refraction) icon goes active. Selecting the Refraction icon opens a window 
from which to enter the patient refraction data. 

 

 

 
Figure 3-2: Entering Refraction Data 

 

Two labels permit opening the right eye (OD) or left eye (OS) chart. If the refraction value entered is the value 
measured on eyeglasses and the corneal apex-to-lens distance is entered in the box for that purpose, the 
system calculates the refraction at the corneal vertex. Enter the values of the sphere in diopters (Sph), the 
cylinder in diopters (Cyl), the cylinder axis in degrees (Ax), and the distance to test eyeglass in mm (@) in the 

relative fields. If the data is incomplete, the warning icon . will appear. If the data are correctly entered, 

the  icon will be displayed 

The patient’s natural visual acuity is entered in the UCVA (Uncorrected Visual Acuity) box; the maximum visual 
acuity attainable with correction is entered in the BCVA (Best Corrected Visual Acuity) box. 

 
The [Cancel] button closes the window without saving the changes. To save the entered data, click the  [OK] 
button or press [Enter]. 

 
 

3.6 Capture 
 

The  Capture icon goes active when a new exam is created or when an empty exam is selected. It permits 
selecting the instrument with which to capture the exam and accessing the capture environment. 
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3.7 Image gallery 
When an exam previously stored as described above is called up, the Gallery window on the right-hand side of 
the main screen will show the images relative to each exam as it is selected. 

 

The images are subdivided by OD (right eye) and OS (left eye). 
 

 

 
 

Figure 3-3: Image Gallery 
 
 
 

A type group may be defined  for each eye in order to facilitate future searches. 
 

 
 

Figure 3-4: Groups 
 

 

Click the  button to open the pull-down menu of the groups entered in the Settings/Groups menu (see Chap- 
ter 19). To enter the eye being examined in a yet-to-be-defined group, select <new group> to open a box in 
which to enter the name of the new group. 

 
 
 

Select a group. The buttons permit associating the right eye group with the left, and vice-versa. 
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You can filter the list of thumbnails in the gallery by selecting one of the filter elements from the dropdown menu: 
 
 
All (default choice), only images, only reports, only movie frames, only lenses or only mosaics. 
 
Clicking an image displays a preview of the summary of the selected examination in the lower portion of the 
screen. 

 

 

 
 

Figure 3-5: Filter 

 
 

 
Double-clicking an image opens the processed image summary (Chapter 5). 

 

 
Right-click a gallery image and select  to add a brief description. 

To eliminate an image, click . 

To open an image, double-click with the left mouse key or press Enter: 

 
• If the selected image is a previously-processed map, the topographic maps viewing environment 

will open. 
• If the selected image is a still-to-be-processed Scheimpflug capture, the image is first processed 

and the summary environment is then opened 
• If the selected image is pupillographic, the pupillography examination will open. 
• If the selected image is an image acquired with the slit lamp, the image viewing environment will open. 
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4. SETTINGS 
 
The Settings menu may be accessed only if the Patients List is not displayed on the main screen. Click the 

 

button to empty the patients list. Then click or open the File menu and select Settings. 
 

4.1 Language 
 

After selecting Settings, the menu for setting the system language will open. 
 

 

Figure 4-1: Settings 

 
Select the language to be used by the software and click [OK]. 

 

 
4.2 Instruments 

Clicking the Instruments label accesses the section for managing the instruments to be used. 
 
 

  
 

Figure 4-2: Instruments Management Figure 4-3: Installed instruments 
 
 
  

Settings 
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Connect all the instruments to use and press the Instruments wizard button . 
You will see the next window with the instruments installed.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4-4. Installed Instrument 

 
Press the Configure button to modify the settings.  

 
 

The  button permits inserting manually a new instrument for use. The instruments must be inserted using the wizard. 
 

 
 

Figure 4-5: Inserting a New Instrument 

 
Enter the model name (reported alongside the exam) and an Executable File (select the SCLive executable 
File), then select the class from the pull-down window shown in Figure 4 4. When done, click [OK]. 

 
After the system has automatically installed the instruments Scheimpflug camera and topographer, it will start 
the first calibration, (see the next paragraph). 
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The button permits editing an existing instrument. 

 
To eliminate an instrument from the list, select it and click            . 
 

 
Click the button to calibrate the instrument. For calibrating, see next paragraph. 

 
In the following setting, you can choose whether to set a timeout in choosing the instrument (5 seconds), 
after which the instrument’s live application will be launched automatically. When not checked, the 
acquisition choice screen will be shown until the user makes his choice. 

4.3 groups 
 

For creating, editing, or deleting groups of examinations. 
 
Cataloguing the examinations by homogeneous type groups (for example: keratoconus, PRK myopia, PPK 
hypermetrophy, trauma, etc.) is useful as a search aid. 

 

 

Figure 4-6 : Groups Menu 

Click the  button to insert a new group. 

The button can be used to edit pre-existing groups. This button goes active when a group is 
selected for editing. 

 

 
The button is instead used to delete a group. It goes active when a group is selected for deletion. 
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4.4 Database  

 

Clicking [Database] accesses the window shown below: 

 

 

 
 

Figure 4-7 : Database Information Menu 
 
 
 

 
Click the unlock button to change image root and Database. 

 
Image root: Clicking the button in this section selects the image management file 
called root.cso. 

 
Database: Using the button to select a file from the database AnaEyes.mdb. 

 
Backup in: Using the button you can choose the destination folder folder backup files 
You can choose the maximum number of backups to perform. 

 
Inheritance by Previous Exam 
 

• When the Groups and Refraction option boxes are selected, each new exam will be attributed 
the group and the refraction data of the last exam created. 
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4.5 Miscellaneous (Other) 
 

Clicking [Miscellaneous] accesses the window shown below: 
 

 

 
 

Figure 4-8: Other Information Menu  
 
 

  Patient Management 
Deselecting Patient ID (external option box) also deselects the other two options (mode and PMS) and it will 
be possible to insert the ID code at the moment a patient is created. 
If this option box is instead selected, it will not be possible to enter the ID code manually. Select one of the 
following two options: 

 
• AnaEyes: the ID code is automatically assigned by AnaEyes when a patient is created. 
• PMS: The ID code and relative personal data will be crossloaded to AnaEyes  from an external database. 

 
The ID of the agency or institution providing the data must be entered in the field alongside 
the PMS item. 

 
Note that in the latter case, the di inserimento paziente è disabilitata. 

 
Study Management 

 
• When ‘Show description’ is selected, the study description will be shown in the main patient tree. 

 
 

 

 
• Otherwise the description will be visible in overlay (meaning, that when the mouse passes over the exami- 

nation, the description will be visible as a tooltip 
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Reminder  
 
The user may select among the following options:  

•  On application closing: displays the message requesting confirmation to close the application.  

•  On deletion: displays the message requesting confirmation to delete an image from the gallery.  

•  On series error: this warning is given when traces of images erroneously moved to other folders or files 
remain in the examination in question.  

•  Assign group: after performing an acquisition a reminder is presented for classification (group 
assignment) of the assigned series.  

 
 

4.6 DICOM (digital Imaging and Communications in Medicine) 
 
DICOM is a medical computer standard adopted by many health agencies and hospitals in all parts of the world, 
which permits medical operators to exchange images and other information via computer systems adopting 
this standard. 

 
Deselect the “Suppress DICOM messages” box to show any errors that do not interfere with image capture. 

 

 
 

 
 

If DICOM is instead selected, the remaining menus must be used. 
 

 

Figure 4-9: AE Configuration  
 

 

Click the  PACS or PMS button to open the following windows: 
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Figure 4-10: PACS and PMS Configuration 

 
 

This window allows the user to identify the PACS system that will receive his information or the PMS system 
from which information may be requested. 

 
In the relative fields enter: 

 
• Title: PACS/PMS ID. 
• Host: PACS/PMS IP address. 
• Port: PC port to which PACS/PMS is referred. 
• Timeout(s): maximum waiting time before disconnecting a call. 

• Limit: for PMS configuration only, identifies the maximum number of exams that may be received. 
If the field is left blank, any number of exams may be received. 

 
Clock [OK] to save the settings as entered; otherwise click [Cancel]. Click [Ping] to initiate a call to the 

PACS/PMS system. Click [Reset] to remove PACS/PMS Setting 

Under local you can configure  the local Application Entity name and port. 
 

 

 

Figure 4-11: Save Parameters 
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The Storage Parameters allow the user to specify several data storage options: 

 
• Secondary capture: by choosing this checkbox, the secondary capture will be sent, instead of the original 

acquisition. This is in fact the image that is shown in the gallery, created in a second moment, after origi- 
nal acquisition. 

• Auto-send: by choosing this checkbox, AnaEyes will be configured to send images immediately after ac- 
quisition. This option is not available when secondary capture is chosen. 

• Lossless: select this box to select the type of compression used for sending, in a 5% to 100% ratio in 5% 
steps, in .jpeg format. Otherwise, the files are sent in the original, uncompressed format. Note that this 
principal is based on a best-fi algorithm: when images are originally acquired uncompressed, all com- 
pression options can be performed; when the image is acquired lossless, it can be forwarded also lossy, 
but not uncompressed; finally , when the image is acquired lossy, it can’t be forwarded other than lossy. 
This option is not available when secondary capture is chosen. 

 

 

Figure 4-12: Java Runtime Environment 

 

This parameter, defining  the environment required for using the functions offered by DICOM, is configured  at 
end of software installation. 

 
Figure 4-13: Choice time-out 

 

4.7 Activations 
 

In this section it is possible to upgrade the license of the software. 
In the section Export it is possible to enable the data export to external applications. 

 

 
 

Figure 4-14: Activation settings 

 
For a number of external applications it is possible to configure the export on the main gallery. The default can be 

chosen from the combo box. Check the reminder if you want a reminder message for exporting both eyes 

contemporarily to the external application. 
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4.8 Schwind 
 

In the ‘Schwind’ section the user may configure  some settings solely for Schwind exports. The back-up folder 
for schwind exports and the export file  name format. 
 

5. CAPTURE 
 
The Capture icon goes active when a new exam is created or when an empty exam is selected. 
This function allows the user to select the instrument with which to capture the examination and to access 
the capture environment. 

 

 
Capture Screen Toolbar 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

on video camera 

 
 
 
 

 
 

 
 
 

 
 
 

 
 

 

 
 
 
 
 

 

 
 

 

 

 

 

 
 

 
Figure 5-1: Toolbar Buttons Summary 

BUTTON SHORTCUT ICON FUNCTION 

Laterality - 
 

Automatic OD–OS recognition 

 
Area of Interest 

 
- 

 Selecting only a part of image 
that  want to view during the 
acquisition 

 
Magnification  2X 

 
- 

 
Allows to magnify 2X the acquisi- 
tion screen 

 

Screen resolution 

 

- 

 Sets image resolution to screen 
resolution. The options to fi ima- 
ge resolution to screen width or 
screen height are also selectable 

Photo Photo/Video button 
 

“Snapshot” capture mode 

 

 
Video 

Photo/Video button on 
video camera 

  
“Video” capture mode 

 

Settings 
 

- 
  

Accesses video camera settings 

 

Reset exposure grid 
 

- 
 

It allows to insert the exposure 
grid during LIVE 

 
Esc 

 
- 

  
Exits the Capture screen 
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The screen shown below will open. 
 

 
 

 

 

Figure 5-2: Capture Window 

 
You can see 9 interest zones when you open the capture window. The exposure has been adjusted for the 
center area. To use an other zone select it with the mouse. 

 
 

 
 

Figure 5-3: Interest zones 
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Click the on the right bar to view the commands relative to video camera parameters, on the right side of the 
screen. 

 

 
 
 

Figure 5-4: Settings Window 
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This panel is used for setting the video camera Gain and Shutter. If Auto is selected, the software will take 
automatic control of these parameters. 

 
AutoExposure sets the average brightness for the image as a whole. In the Auto mode, the video camera 
tends to adjust Gain and Exposure in such a manner as to bring the AutoExposure value to the preset 
value. It goes without saying that there are situations in which the interplay of light and dark areas in the 
image can lead to excessive brightness in the lighter areas. 

 
 

 
 

 
Figure 5-5: Profiles 

 
You could enable a profile  pressing REGS on the digital camera or clicking with mouse on the box. 

To modify the configuration you need to open the menu and save or rename the modified done. 

After you have selected the profile,  edit the image parameters and press save. 
 

 
 

Figure 5-6: Rename or save profile 

 
The user may create and save four different camera setting configurations. 
The Profiles  button on the digital separator panel activates one or another of these configurations 

 
LIVE from the acquisition will be possible to retrieve the saved configuration by clicking the appropriate 
button and the camera will set the settings associated with the button. 

 
The default profile  contents the original settings of the camera and it cannot be modified  

After you have modified and saved one of the three profiles, a small icon will be viewed. 

 

 

 
Figure 5-7: Modified  profile 
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In the menu will be added a new link “Restore” to return to default settings. 
 

 
 

Figure 5-8: Restore default value 
 

 

 
 

Figure 5-9: Set Configuration 
 

 
The Multishot mode permits enabling capture of a number of images by a single joystick click. In this case 
select the numbers of images between 1 and 7. 

 
 

 

 

Figure 5-10: Mutlishot 
 
 
 

Selecting the Gamma check-box, enable the gamma correction modifying the value. 
 
 

 

Figure 5-11: Gamma correction 
 
 
 
 

Selecting the Deep check-box you can use the max value of sharpness to obtain a good definition. 
 
 
 
 

 

Figure 5-12: Gamma correction 
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5.1 Capture settings 

 
 
   

Press the     button to open the capture setting. 

 

 
 

Figure 5-13: Capture settings 
 

 
Acoustic feedback 

 
It allows to select the acquisition acoustic feedback. 

 
Image format 

 
You can choose the image extension, Tiff, Png or Jpeg. 

 
The Quality cursor is enabled only for Jpeg, so you can choose the level of image quality. 

 
      The “Onboard memory flag” allows better photo acquisition 
 

Video settings 

 
Timeout(s) is the maximum duration of a movie. 

 
Hi-res flag enables hi-res videos at 1280x960, anyway a fast cpu is required in order to reduce 
the loss off luidity. 

 
Laterality 

 
Selecting Auto LR it is possible the automatic laterality L – R. Unable the Auto LR, you can choose the 
laterality 

 

during the acquisition pressing the laterality button   and then acquire using the joystick. Switch 
laterality allows to invert the laterality. 

 
Stream 

Choose Mirror to switch left and right on the camera’s sensor 
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Choose Flip to switch up and down on the camera’s sensor Choose 

Show FPS to show the camera’s frame rate while in live 

Preview after shot shows the acquired photo on-screen just after being shot 

 
Photo acquisition streaming and Video acquisition streaming provide for combo boxes where you can 
choose for both acquisition modes whether the streaming should be in full resolution 
 

(more definition, less fluidity or lower framerate) or reduced resolution) 

(less definition, more fluidity or higher framerate) 

 
 

 
5.2 Photo Capture 

 
Before beginning photo capture, first check that the correct toolbar icon is active: . 

 
Press the joystick button to capture the image. The eye in question (left or right, OS – OD) will be 
automatically detected. Up to 24 images may be captured for each examination. 

 

 
5.3 Video Capture 

 
To capture videos, press the Photo/Video button on the camera. The toolbar icon will switch to . 
Selection may also be accomplished by simply clicking the toolbar icon. 
Press the joystick button to start filming  (video capture); press again to stop. 

If video capture does not stop for any reason, the capture mode will close automatically at the end of the 
preset Timeout time. 

 
 
6. IMAGE GALLERY MANAGEMENT 

 
 
Double-click any image in the gallery to open the image management and processing screen. 

 

 

Figure 6-1: Image Management Window 
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The and buttons may be used to view the gallery images. 
 

 
The button may be used to scroll all the images at selected time intervals, varying from 0.1 to 5 second. 

 

 
 

 
6.1 Toolbar buttons Summary 

 

BUTTON 
KEYSTROKE
SHORTCUT 

ICON 
FUNCTION 

 
Compare 

 
- 

 
Compares two or more mages 

from the gallery. 

 
Full screen 

 
F11 

 

 

Adapts to full screen the elabora- 
tion window 

 
Delete 

 
CANC 

 

 
 

 
Deletes the displayed image. 

 
Calibration 

 
- 

  

Creates and assigns new 
calibrations. 

 

Close 
 

-  
 

Closes the image management 
screen and returns to the gallery. 

 
Zoom 

 
- 

 

 
 

Shows the image enlargement 
percentage with respect to 

original image size. 

View measure 
buttons 

 

- 

 

 

View the toolbar for the 
measurements 

 
Distance 

 
- 

 

 
 

Measures distances in pixels or 
mm. 

 
Angles 

 
- 

 

 
 

 
Measures angles, in degrees. 

 
 

Cup to disc ratio 

 
 

- 

 

 
 
 

Calculates ratios between two 
circular areas defined  by the 

user in terms of surface area and 
diameter. 
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Line - 

 

 

Draws a line on the image. 

 

Rectangle 
 

- 

 

 

Draws a rectangle on the image 

 

Text 
 

- 

 

 

Allows the user to overwrite the 
image with a line of text. 

 
Delete 

 
- 

 

 

Removes the graphics and text 
added to the image. 

 
Scroll Back 

 
PgDn 

 

 

Scrolls backwards through the 
gallery images. 

 
Scroll forward 

 
PgUp 

 

 

Scrolls forward through the galle- 
ry images. 

 

View Series 

 

- 

 

 

 

Scrolls and displays the gallery 
images automatically, 

at the time interval set by the 
user 

 

6.2 Menu bar 
 

The menu bar at the top of the main screen lists the following menus: 

 

 
 

Figure 6-2: Image Management Menu 

 
6.2.1 file 

 
The File menu is composed of 6 submenus, as described below: 

 
              (Save screen as image) Takes a snapshot of the current screen. 

 

 
(Save image) Saves an image in a user-selected  
format: (JPEG, BITMAP, GIF, PNG, TIFF). 

 

               (Close) Returns to the main window. 
 
 

              (Print screen) Prints the screen containing the image. 
 
 

  (Print) Prints up to 4 images chosen by the user, on a single       
page (see Section 7, Printing); 

 

(             (Esc) Exits the program. 
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6.2.2 analysis 

 
The Analysis menu allows the user to access the Comparison feature for comparing up to six different 
images and then returning to single-image display. 

 
 
 

 
 

Figure 6-3: Analysis Menu 
 
 
 

When a single image is displayed, the relative menu item is not enabled. 
Select Compare to access the screen that permits selecting images for comparison. 

 

  The comparison screen may also be accessed by clicking the button on the toolbar. 
 
 

 

Figure 6-4: Selecting Images for Comparison 

 
Double-click gallery images to display them in the right-hand column before they are displayed all together in 
a single screen view. 
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Figure 6-5: Image Comparison 
 

 
The File menu in this screen reiterates the same functions described in Section 6.2.1. 
The Analysis menu disables Compare and re-enables Single Image. 

 

 
 

Figure 6-6: Single Image 

 
6.2.3 Options 

 
 

 

 
Figure 6-7: Options Menu 

 
The Options menu contains 4 submenus: 

 

Displays general information on the patient and the examination in question. 
 

 
Eliminates the pixelating effect that appears when the image is greatly 
enlarged. 

 

Allows the user to choose the measurement units for linear measurements, 
expressed in mm or microns. 
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Opens two submenus for: 

 

 
o changing the text font 
o changing the width of the line used for drawing (line size). 

 
6.2.4 Tools 

 
See Section 6.1 for the Tools menu functions. 

 

 

 
 

Figure 6-8: Tools Menu 

 
Overlay goniometer 

 
Select this option to put a goniometer clicking in the image. 

 
6.2.5 filters 

 
This menu allows the user to modify the image color and brightness characteristics: 

 
 
 
 

 

These three submenus permit the user to modify the image brightness, 
contrast, and correction range: simply select a function and scroll the mouse wheel. 

 
 
 
 
 

Select a color to vary the percentage of red, green, or blue in the image. 
 
 

Opens two submenus for inserting a yellow or a cyan filter over the image. 
 
 
 

Restores the original values present in the image as captured. 
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6.3 Calibration 

 
6.3.1 Creating a new calibration 

 
The user may create a calibration set based on the enlargement ratio, for facilitating linear measurements. 

 
Use a grid paper as your slit lamp target (for example, graph paper with 1-mm divisions). Capture an image 
of the target at 15X / 16X enlargement and save it in the gallery. Open with double click with the mouse the 

 

image and press the toolbar button. 
 

Select (calibrate with this image). 
 
 

 

 

Figure 6-9: Calibration Menu 

 
The screen shown below will appear. On this screen, the user must make the red grid coincide with the 
squares on the graph paper. Drag the white squares at the corners of the red grid until it coincides with the 
real measurement of the graph paper. Each red square measures 1 mm x 1 mm. 

 

 
 

Figure 6-10: Millimeter Grid 

 
Figure 8-9 shows capture of a calibration target divided into squares of 0.5 mm x 0.5 mm size. 
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The   message box reports the measurement of the grid as a whole. 

If need be, the whole-grid measurement may be modified by scrolling the mouse wheel. When the grid is 
correctly positioned, click the OK button. 
To assign the calibration thus obtained to all the images contained in the examination in question, click YES. 

 
 

 

    

Figure 6-11: Assigning a Calibration 
 

 
6.3.2 Measurements 

 
Open the image, press the calibration button and select the magnification of the image captured. 

 
 
 

 

 
 

Figure 6-12: Select the magnification 

 
After having associated a calibration with an image, the user may make linear measurements by clicking the 

 
 
 

button on the toolbar. 

 
Measurements may be made in mm or in microns (Options menu, 6.2.3). 
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Figure 6-13: Measurement in Millimeters 

 
Before to perform the linear measurements, We advice to check if the calibration is good or not. Capture  
more images of the grid paper using different magnification and check if the measurements are correct. 

 
warning: The measurements supplied by the software are subject to many variables. for this 
reason they must be considered as purely indicative. Evaluation of any measurement should be 
entrusted to competent medical personnel. CSO declines any responsibility for damages/injuries 
caused by use of the measurements. 

 

 
6.4 Playing video 

 
Clicking on the gallery image you will play the video. 

 
To save the video, open the menu with right-click of the mouse and select save. The video will be saved in 
the selecting path. 

 
With double-click of the mouse you will see the video management (using Windows Vista this function is 
disabled). 
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Figure 6-14: Video management 

 
In the gallery you will see the frames of the video. It is possible to see two different frames together in the 
same window. The red square regards the first frame and the blue square regards the last frame. 

 

 

You can see all the frames using the toolbar . You can see the time between 
2 frames. 

 
 

Shows the red square image. 
 
 

Shows the blue square image. 
 
 

Shows the 2 images. 
 
 

Allows to save the red square frame. 
 
 

Allows to save the blue square frame. 
 
 

Saves the time range. 
 

 
Loads the time range. 

 
The frames were saved in the right vertical gallery. 
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(Save screen as image) Takes a snapshot of the current 
screen. 

 
 

(Close) Returns to the main window. 

 

(Print screen) Prints the screen containing the image. 

 

(Esc) Exits the program. 
 
 

7. PRINTING 
 

The user may print a single image or multiple comparison images. 

 
Select Print 6.2.1 from the File menu to open the screen for selecting the images to be printed. 

 

 
 

 
 

Figure 7-1: Selecting Images for Printing 
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Select the images to be printed by double-clicking images in the gallery on the right-hand side of the screen. 
The selected images will be copied into the lower right-hand corner of the screen. 
Printing is possible only if a printer is connected to the instrument. 

 
The image/s may be printed on paper (Print button) or converted to PDF format (PDF button). 

 
In the first case, the PC must be connected to a printer. 

 
In the second, the user may choose the file destination: desktop or gallery.  

 

 
Click Yes or No. 

 

7.1.1 Printing Toolbar 

 

 
 
 

 

Update 

 
 

Refreshes the print preview image to show modifications. 

 

 
Options 

 

Permits changing the print settings. 

 

 

Print 

 

 
Prints the page shown in the Preview. 

 

 
 
Enlarge – Reduce Preview 

 

Enlarge – Reduce Preview (%) of the image. 

 
 
 

Show/Hide Heading 

 

Displays or hides the heading (if inserted) and relative logo. 

 
 
 

Edit Heading 

 

Permits changing the text of the heading and the logo: click the button 
to show the heading data entry/change form (Figure 7-2). 

 
Patient header 

 
  Print the patient header 

 

 

Exits the Printing window. 
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APPENDIX A.            
 
IMPORT-EXPORT EXAMS 

 
a. Exporting an examination 

Exporting an examination or a patient, select with right-button of the mouse on the examination and click 
export. 

 
 
 
 
 
 
 
 

 
Figura 8-1: Export examination 

You will see the editing screen of the anagrafic data to be exported. 

Edit the data if you want and select OK. 

It will be exported the file.zcs. 

 

 
 

Figura 8-2: File esportato 
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b. Importing an examination 

 
To import a previously exported file.zcs, you must open the archive containing the file,  and drag the column 
occuped by the patient list, as shown in the next window : 

 

 
 

Figura 8-3: Import file 
 

 
Wait a few seconds and the patient will appear in the list. 

 
 

 
APPENDIX B .SAFETY 

 
For data security, please refer to the management of Windows security. 
It is recommended to enter a password to access the account used. 
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